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Kit Description

This kit provides the software-license password document and instructions to
upgrade the software on your existing MTS300 MPEG Test System or on your
existing MTS300 Software Only product.

These instructions apply for the following MTS300 software field upgrades:

� MTS3FDT (MPEG-2 Deferred Time Analysis System)

� MTS3FOC (ViAccess Conditional Access)

� MTS3FES (MPEG-2 Audio/Video Elementary Stream Analyzers)

� MTS3FPS (Program Stream Analyzer)

� MTS3FAC (MPEG-2 Dolby Digital (AC-3) Analyzer)

� MTS3FOM1 (OpenMux Real-Time Multiplexer)

1 The MTS3FOM software field upgrade is available only for MTS300 MPEG Test System instruments. You cannot upgrade a
MTS300 software-only product with the MTS3FOM software field upgrade.
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Kit Parts Lists
Tables 1 through 6 list the items that are shipped with the various MTS300
software field upgrades covered by this kit.

NOTE. The MTS300 Stream Creation Applications User Manual (Tektronix part
number 071-0778-XX), which was supplied with your original MTS300
instrument or software-only product, contains user information for the applica-
tions enabled by the MTS3FDT, MTS3FOC, and MTS3FOM upgrades.

Table 1: MTS3FDT parts list 

Quantity Part number Description

1 EA NS BOX, SHIPPING; 12.50 X 9.0 X 3.0 INCHES

1 EA NS DATA SHEET; SOFTWARE KEY INFORMATION

1 EA 063-1914-00 SOFTWARE PKG; MPEG2 ELEMENTARY STREAMS CD-ROM

1 EA 071-0659-00 MANUAL, TECH, USER; MPEG-2 DVB/ATSC SYSTEM
ANALYZER

1 EA NS MANUAL, TECH, INSTALLATION; MTS300 SOFTWARE FIELD
UPGRADES

1 EA 063-2927-00 SOFTWARE PKG; CD-ROM, STRM102

1 EA 070-9644-01 MANUAL, TECH, USER; STRM100/STRM101/STRM102

1 EA NS FORM, PRINTED; SOFTWARE LICENSE AGREEMENT

1 EA NS REGISTRY CARD SITE LICENSE, MAIL BACK REGISTRATION
CARD; STRM100

NS – Not Saleable

Table 2: MTS3FOC parts list 

Quantity Part number Description

1 EA NS BOX, SHIPPING; 12.50 X 9.0 X 3.0 INCHES

1 EA NS DATA SHEET; SOFTWARE KEY INFORMATION

1 EA NS MANUAL, TECH, INSTALLATION; MTS300 SOFTWARE FIELD
UPGRADES

NS – Not Saleable



Kit Description

MTS300 Software Field Upgrades 3

Table 3: MTS3FES parts list 

Quantity Part number Description

1 EA NS BOX, SHIPPING; 12.50 X 9.0 X 3.0 INCHES

1 EA NS DATA SHEET; SOFTWARE KEY INFORMATION

1 EA 071-0663-00 MANUAL,TECH; USER, AUDIO STREAM ANALYZER

1 EA 071-0664-00 MANUAL,TECH; VIDEO ELEMENTARY STREAM

1 EA NS MANUAL, TECH, INSTALLATION; MTS300 SOFTWARE FIELD
UPGRADES

NS – Not Saleable

Table 4: MTS3FPS parts list 

Quantity Part number Description

1 EA NS BOX, SHIPPING; 12.50 X 9.0 X 3.0 INCHES

1 EA NS DATA SHEET; SOFTWARE KEY INFORMATION

1 EA 071-0662-00 MANUAL, TECH, USER; MTS300 PROGRAM STREAM
ANALYZER

1 EA NS MANUAL, TECH, INSTALLATION; MTS300 SOFTWARE FIELD
UPGRADES

NS – Not Saleable

Table 5: MTS3FAC parts list 

Quantity Part number Description

1 EA NS BOX, SHIPPING; 12.50 X 9.0 X 3.0 INCHES

1 EA NS DATA SHEET; SOFTWARE KEY INFORMATION

1 EA 071-0661-00 MANUAL, TECH, USER; MTS300 AC-3 AUDIO STREAM
ANALYZER

1 EA NS MANUAL, TECH, INSTALLATION; MTS300 SOFTWARE FIELD
UPGRADES

NS – Not Saleable
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Table 6: MTS3FOM parts list 

Quantity Part number Description

1 EA NS BOX, SHIPPING; 12.50 X 9.0 X 3.0 INCHES

1 EA NS DATA SHEET; SOFTWARE KEY INFORMATION

1 EA NS MANUAL, TECH, INSTALLATION; MTS300 SOFTWARE FIELD
UPGRADES

NS – Not Saleable
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Installation Instructions

The installation procedure is the same for all of the MTS300 software field
upgrades. The upgrades differ in which applications are activated when you enter
the General License Password. Refer to Licensed Applications on page 7 for a
list of the applications that are included with each software field upgrade.

Verifying the Existing Installation
The installation of the MTS300 software field upgrades requires that your
existing installation of the MPEG Test System software includes icons for each
of applications that will be enabled with this software upgrade. Figure 1 shows
the Tektronix MPEG Test System program group window containing icons
representing all of the applications supplied with MTS300 software version 5.0.

Verify that your existing Tektronix MPEG Test System program group window
contains the application icons that will be enabled with your software upgrade.
Refer to Licensed Applications on page 7 for a list of the applications included
with each of the MTS300 software field upgrades.

NOTE. If your current MTS300 installation is missing any of the application
icons that will be enabled with your software upgrade, you must reinstall
MTS300 software version 5.0 before the MPEG Test System application
purchased with this upgrade can be enabled. Refer to your existing MTS300
documentation for instructions on how to reinstall the application software.

Figure 1: MTS300 MPEG Test System version 5.0 program group window
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Entering the General License Password
Perform the following steps to enter the General License Password supplied with
this upgrade kit. Doing so enables the applications you purchased with your
MTS300 software field upgrade.

NOTE. The General License Password supplied with this software upgrade kit
supercedes the password supplied with your original MTS300 installation.
Discard the original password document and use the new General License
Password supplied with this kit when you need to reinstall the MTS300
application software.

1. Verify that the software protection key supplied with your original MTS300
installation is installed on the parallel port of the MTS300 instrument or on
the parallel port of the computer containing the MTS300 software-only
product.

NOTE. You will not be able to upgrade the MTS300 application software if the
software protection key is not installed.

2. Double-click the License Manager icon in the Tektronix MPEG Test
System window to start the application. The Tektronix Software Protection
window appears.

3. Consult the password document supplied with this MTS300 software
upgrade and identify the General License Password.

4. Enter the three 6-character Hexadecimal numbers of the password in the
corresponding Tektronix Software Protection window entry fields
(lowercase characters are acceptable) and then click OK. A License message
window appears.

5. If the password is correct, click OK to acknowledge the message. If you
made an error entering the password, click OK to acknowledge the error
message and return to step 3.

6. After you enter the correct General License Password, reboot your MTS300
instrument or computer.

The installation of your MTS300 software field upgrade is now complete. You
can verify that the software installed properly by performing the appropriate
procedure(s) located in Verifying the Installation on page 9.
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Licensed Applications
The following applications are included with all Tektronix MTS300 MPEG Test
Systems and MTS300 software-only products:

� License Manager

� Error Injector

� MPEG-2 Help

� Uninstall MTS V5.0

The General License Password included in this kit enables additional applica-
tions that correspond to the MTS300 software field upgrade you purchased as
listed in Table 7. You can sample the remaining applications free of charge for
thirty days; refer to Demonstration License on page 8 for more information.

Table 7: Licensed applications 

Product Licensed applications

MTS3FDT Deferred-Time Analyzer

Multiplexer

DVB Channel Coder/Decoder

DVB Table Editor

ATSC Table Editor

Jitter Adder

MTS3FOC NA (adds ViAccess Conditional Access to your existing
Deferred-Time Analyzer and Multiplexer applications)

MTS3FES Audio Stream Analyzer

Video Stream Analyzer

MTS3FPS Program Stream Analyzer

MTS3FAC Dolby Digital (AC-3) Audio Analyzer

MTS3FOM1 OpenMux (Real-Time Multiplexer)
1 The MTS3FOM software field upgrade is available only for MTS300 MPEG Test

System instruments. You cannot upgrade a MTS300 software-only product with the
MTS3FOM software field upgrade.

To delete the icon of an unlicensed application from the Tektronix MPEG Test
System program group, select (highlight) the icon, press DEL, and click Yes in
the resulting message window.
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To remove an unlicensed application from the Start/Programs/Tektronix MPEG
Test System menu, start Windows NT Explorer and open the following path:
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Then drag the application shortcut from the right-hand Exploring window pane
to the Windows NT Recycle Bin. Refer to your Windows NT documentation for
more information about changing the appearance or contents of the desktop,
program groups, and the Start menu.

Demonstration License
The setup application installs files, icons, and menu items for all MTS300
applications listed in the previous section, even though some applications are not
standard with your product. You can activate a Demonstration License to enable
all unlicensed applications for thirty days. When you attempt to start an
unlicensed application, the License Management dialog box opens.

Consult the password document supplied with your MTS300 MPEG Test System
product and identify the Demonstration Password. To activate the Demonstration
License, enter the eight-character hexadecimal password in the License
Management dialog box, and then click OK. Once you have correctly entered
the Demonstration Password, all unlicensed or optional applications are available
for the following thirty day period.

NOTE. The Demonstration License applies to all unlicensed applications
concurrently and cannot be renewed. Be sure to try all applications of interest
within thirty days of activating the license.

To purchase additional MTS300 applications or options, please contact your
Tektronix representative or nearest Tektronix field office.
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Verifying the Installation
After you complete the installation of the MTS300 application software, use the
procedures in this section to verify the operation of your licensed applications.

MTS3FDT enables both the Multiplexer and Deferred-Time Analyzer applica-
tions. Perform the following steps to verify the operation of these applications
(notice that you cannot run both applications simultaneously):

1. Double-click the Deferred-Time Analyzer icon in the Tektronix MPEG Test
System program group window to start the application.

2. Select Open from the MPEG2 System Analyzer File menu and open the
following transport stream file: ���������� ��!�	"����"�
#�	".

3. Verify that a Hierarchic View of Sample.trp window opens within the
MPEG2 System Analyzer application window.

4. Exit the MPEG2 System Analyzer application.

5. Double-click the Multiplexer icon in the Tektronix MPEG Test System
program group window to start the application.

6. Select Open from the Multiplexer File menu and open the following
configuration file: ���������� ��!�	"�$
�����#���.

7. Exit the Multiplexer application.

MTS3FOC enables ViAccess Conditional Access, which adds scrambling/CA
capabilities to both the Multiplexer and Deferred-Time Analyzer applications.
Perform the following steps to verify the operation of this option:

1. Double-click either the Deferred-Time Analyzer icon or the Multiplexer
icon in the Tektronix MPEG Test System program group window to start one
of the applications.

2. Verify that the Conditional access license... command is no longer present
on the Options menu of the just-started application. In the Deferred-Time
Analyzer application, Unscrambling is now the third command in the menu;
in the Multiplexer application, Scrambling is the second command in the
menu. The Multiplexer Scrambling command is available when a new or
existing configuration file is open.

3. Exit the application you opened in step 1 of this procedure.

MTS3FDT

MTS3FOC
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MTS3FES enables both the Audio Stream Analyzer and the Video Stream
Analyzer applications. Perform the following steps to verify the operation of
these applications:

1. Double-click the Audio Stream Analyzer icon in the Tektronix MPEG Test
System program group window to start the application.

2. Select Open from the Audio Stream Analyzer File menu and open one of the
*.mp2 files in the following directory: ������������%�
.

3. Verify that both a First Level View and a Characteristics window open
within the Audio Stream Analyzer application window.

4. Exit the Audio Stream Analyzer application.

5. Double-click the Video Stream Analyzer icon in the Tektronix MPEG Test
System program group window to start the application.

6. Select Open from the Video Stream Analyzer File menu and open one of the
*.mp2 files in the following directory: ����������&�%

�'(' (or \625).

7. Verify that both the Main view window and a window containing MAIN
CHARACTERISTICS open within the Video Stream Analyzer application
window.

8. Exit the Video Stream Analyzer application.

MTS3FPS enables the Program Stream Analyzer application. Perform the
following steps to verify the operation of this application:

1. Double-click the Program Stream Analyzer icon in the Tektronix MPEG
Test System program group window to start the application.

2. Select Open from the File menu.

3. In the Open dialog box, select MPEG2 Program Stream in the List files of
type list box.

4. In the Open dialog box, select Sample.pck from the following directory:
�������������	
��.

5. Verify that a Hierarchic View window opens within the application window
showing the selected program stream.

6. Exit the Program Stream Analyzer application.

MTS3FES

MTS3FPS
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MTS3FAC enables the MPEG-2 Dolby Digital (AC-3) Audio Analyzer
application. Perform the following steps to verify the operation of this applica-
tion:

1. Double-click the Dolby Digital Analyzer icon in the Tektronix MPEG Test
System program group window to start the application.

2. Select Open from the File menu and open one of the *.ac3 files in the
following directory: ������������%�
.

3. Verify that both a Frame View and a Main Characteristics window open
within the application window.

4. Exit the Dolby Digital Analyzer application.

MTS3FOM2 enables the OpenMux application. Perform the following steps to
verify the operation of this application:

1. Open the Master Client application by double-clicking the Master Client
icon in the Tektronix MPEG Test System program group window.

2. Click the Connect locally button on the toolbar as shown below. The Master
Client application now displays the available I/O ports showing that you are
connected to a Server Manager (in this case the local Server Manager).

2 The MTS3FOM software field upgrade is available only for MTS300 MPEG Test System instruments. You cannot upgrade a
MTS300 software-only product with the MTS3FOM software field upgrade.

MTS3FAC

MTS3FOM
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3. In the Master Client Port Manager panel, right click the I/O port from which
you will output the transport stream, point to Assign Server in the popup
menu, and then select OpenMux from the submenu.

The Free icon will change to the OpenMux icon. In the following illustra-
tion, the OpenMux server is being assigned to I/O port 2.

4. Right-click the OpenMux icon in the Port Manager panel, and select
Launch OpenMux Configuration Client from the popup menu. The
OpenMux Spy view is displayed. The first time the OpenMux Spy View is
displayed, the window is blank except for the server icon in the center of the
window.

5. Select Multiplex Rate from the Multiplex menu.

6. Enter 30000000 Bits/s in the Multiplex Rate text box, and then click OK.
The multiplex rate is updated in the OpenMux Spy view.

7. Select Add Input from the Input menu, and then select PSI-SI-PSIP from
the submenu. The Advanced PSI dialog box is displayed.

8. Click Apply to accept the default values and close the dialog box. The
PSI-SI-PSIP input icon is added to the OpenMux Spy view.

9. Select Add Input from the Input menu, and then select Transport File from
the submenu. The Input File dialog box is displayed.

10. Click Browse and use the Select Transport Stream dialog box to select the
following transport stream file: ���������� ��!�	"����"�
#�	".

11. Click Apply to accept the default values and close the dialog box. The
Transport Stream icon is added to the OpenMux Spy view.
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12. Select Add Input from the Input menu, and then select ES Program from
the submenu. The ES Program dialog box is displayed.

13. In the ES Program dialog box, click Browse in the MPEG-2 Video
Component group. Use the Select Video File dialog box to select the
following video elementary stream file:
����������&�%

�'('��
)�*�+�#�"(.

14. In the MPEG-2 Audio Component group, ensure that the Add Audio
Component check box is selected.

15. Click Browse in the MPEG-2 Audio Component group and use the Select
Audio File dialog box to select the following audio elementary stream file:
������������%�
�,��-.#�"(.

16. Click OK to accept the changes and close the dialog box. A Program icon is
added to the OpenMux Spy view.

17. In the OpenMux Spy view, double-click the Transport Stream icon (labeled
Sample). The Control View window for the input is displayed.

18. In the Control View window, click the � (Start) button.

19. Close the Control View window.

20. In the OpenMux Spy view, double-click the Elementary Stream Program
icon (labeled ES Program). The Control View window for the input is
displayed.

21. In the Control view, click the � (Start) button.

22. Close the Control View window.
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23. Start the multiplex by selecting Start Multiplex from the Multiplex menu or
by clicking the � (Start Multiplex) button on the toolbar.

You are now generating a simple transport stream using the inputs you
specified. The OpenMux Spy view should look similar to the following
illustration.

Transport stream
icon

Elementary stream
program icon

Output
icon

PSI-SI-PSIP
icon

24. Verify the signal output:

a. In the OpenMux Spy view, right-click the Output icon and verify the
popup menu contains the following entries:

� Hierarchic View

� Program Multiplex Allocation

� PID Multiplex Allocation

b. Select PID Multiplex Allocation from the popup menu. The PID
Multiplex Allocation View is displayed.

c. In the PID Multiplex Allocation view, verify that the rate for PID 50 is
approximately 20.5 % of the total multiplex rate (roughly 6.13 Mbps).

25. Exit the OpenMux application, and then exit the Master Client application.

� End of document �
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